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Zusammenfassung

Diese Arbeit befasst sich mit der UntersuchungRierkausbreitung und Antennen fir Radio
Frequency ldentifikation (RFID)-Systeme im Frequmreich der Hochfrequenz (HF) im
13,56 MHz Band und im Ultra-Hochfrequenz (UHF) Bawdschen 866MHz und 960 MHz.
Im Rahmen dieser Arbeit wurde mit Hilfe einer Faluslationssoftware eine Antenne
entwickelt, gefertigt und vermessen, welche siaghR&ID-Anwendungen im HF- und UHF
Bereich eignet und im typischen Kreditkartenform@5,725 mm x 53,975 mm bzw.
3%s, x 2'/5") realisiert wurde. Die Antenne setzt sich auseeiplanare Schleifenantenne fiir
den HF-Bereich und einem Faltdipol fir den UHF-Bgrezusammen. Im Fokus der
Untersuchungen stehen Kopplungseffekte zwischen eiezelnen Antennen. FUr die
Untersuchungen im HF-Bereich wird auf feststehemdiedelle zurlickgegriffen, wobei
hingegen der UHF-Bereich mit Hilfe eines Softwakegia (AWR) entwickelt und analysiert
wird. Zum Schluss wird auch die Kombination der émte untersucht. Die Ergebnisse
werden im UHF Bereich mit einer NXP Referenzanteverglichen. Die entwickelte Antenne
arbeitet im HF als auch im UHF Bereich, wodurchednessere Lesereichweite erreicht wird.
Die Simulationsergebnisse werden durch Messungefiziert.

Abstract

In this paper radio wave propagation and antenoasaflio frequency identification (RFID)
systems in the frequency range of the high frequéH€) in the 13.56 MHz band and in the
ultra-high frequency (UHF) band between 866MHz @60MHz are investigated. With the
help of a field simulation software an antenna besn designed, fabricated and measured,
which is suitable for RFID applications in the HRdaJHF range, typically to apply in credit
card size (85,725 mm x 53,975 mm or rathiég, % 2Y/g). The antenna is a combination of a
planar loop antenna for the high-frequency rangkafolded dipole for the UHF range. The
main focus of the investigations are coupling @¢ffdoetween the individual antennas. The
tests in the HF range are accomplished by fixedatspavhile the UHF range is designed and
analyzed by the means of a software package (AWRally, the combination is analyzed.
The results are compared to a NXP reference antdi@adeveloped antenna operates in the
HF and UHF range, leading to a better reading niegtaThe simulation results can be verified
by measurements.

Institut fiir Hochfrequenztechnik 4
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1 Einfihrung

Auto-ID  (Automatische Identifikation) Systeme spiel eine grol3e Rolle in

unterschiedlichsten Branchen, wobei ihr Einsatzstneerschieden ist. Das Hauptziel der
Auto-ID Systeme ist die Anweisung von Information&her verschiedene Produkte und
Konsumartikeln. RFID Systeme unterschiitzen die Ektung von kombinieren Antennen

fur den HF-und UHF-Bereich um die Lesereichweiteveubessern. Im Folgenden ist eine
Erklarung der RFID Systeme gegeben.

1.1 RFID Systeme

“Radio-Frequency-Identification (RFID), zu DeutscHIdentifizierung mit Hilfe
elektromagnetischer Wellen* oder Identifikation cluiRadiowellen, erlaubt die automatische
Erkennung und Lokalisierung von Objekten als auelbdwesen und erleichtert damit die
Datenerhebung [1]. RFID Systeme setzen sich ausGmmdbestandteilen zusammen:

* Lesegerat

e Transponder

RFID- RFID-
Erfassungs- ) ] ( ( Transponder
gerit mit Chip und

{Transmitter) Antenne

Takt und Energie
—h.

Daten

Applikation

Abb. 1.1: Prinzip eines RFID — Systems [1]

Die verwendete Arbeitsfrequenz erlaubt die Untezghimg verschiedener Arten von RFID
Systemen:

» Hochfrequenz (HF) Systeme operieren bei 13,56 MHK#&pitel 3.3 fur Details

» Ultra Hochfrequenz (UHF) Systeme operieren bei 880-MHz &. Kapitel 3.4 fur
Details)

Institut fiir Hochfrequenztechnik 11
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Die Kopplung erfolgt durch magnetische Wechselfeldeslche von Lesegeraten oder durch
hochfrequente Radiowellen erzeugt werden. Dabeilevegleichzeitig Daten Ubertragen. Der
Transponder ist bekannt als RFID Label oder RFID. Txas Lesegerat mittels einer Software
gesteuert, welche den tatsachlichen Lesevorgamgmont [1].

1.2 Anwendungen HF/UHF

» HF: Sicher, personenbezogene Daten z.B ZugangshientPayment

* UHF: GroR3e Reichweite, objektbezogene Anwendungé&hl.ogistik
RFID- Anwendungsbereiche [3]:

» Tickets fur offentlichen Verkehr

* Im Automobilbereich

* Als Produkt-Index

* Lebensmittelkette

* Pharmazie-Markt

* Bekleidungsindustrie

» Elektronischer Passport und e-Visas

» Kontaktlos-Kreditkarten

* NFC

» Coilon Chip

* Medizinische Anwendungen, usw

1.3 Motivation

Es existiert bereits die Kombination einer HF- ubéiF-Antenne, in welcher fir die
Antennen jeweils ein Chip eingesetzt wird. Da esePschiedenen Chips gibt, wurde die
Information separat eingelesen und es ergab sieh lB@stimmte Lesereichweite. Durch eine
weitere Verwendung von RFID Systemen konnen wir demzess moglicherweise
vereinfachen. Die vorliegende Diplomarbeit analgsigie durch die Zuverlassigkeit bei
entsprechendem Design und entsprechender AnorddangAntenne in 2 verschiedenen
Frequenzbereichen mit nur einem eingesetzen Clwpl esereichweite verbessert werden
kann. Die zwei Frequenzbander missen so getrenmtewedass sich die Antennen nicht
gegenseitig storen, da ansonsten die HF die UHEskhlie3t und umgekehrt.

Institut fiir Hochfrequenztechnik 12
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2 RFID Theorie

Dieses Kapitebefasst sich mit den Grundlagen der RFID TheorgeHie- und UHF-Bereichs.

2.1 Verwendete Begriffe und Ausdricke

Term Beschreibung Einheit
E elektrische Feldstarke V/m
H magnetische Feldstarke A/m
B Magnetfluss Intensitat T =Vs/m?
D elektrischer Fluss Intensitat As/m?
J elektrische Stromdichte Al m?
&, elektrische Feldkonstante = 8.854x10*? As/Vm
o magnetisch&eldkonstante =12566x107Vs/ Am
L Induktivitat H =Vs/ A
M Gegeninduktivitat H=Vs/A
Y magnetischer Fluss Wb=Vs
P Ladungsdichte As/m?®
A Wellenlange m
c Lichtgeschwindigkeit =3x10°m/s
F Frequenz Hz
z Impedanz Q (Ohm)
N Windungszahl -
P Leistung Watt (W)

Tabelle 2.1:Verwendete Begriffe und Ausdriicke

Institut fiir Hochfrequenztechnik 13
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2.2 Elektromagnetische Wellen

Als elektromagnetische Welle bezeichnet man eindleNsis gekoppelten elektrischen und
magnetischen Feldern. Der Ursprung und die Ausbrgitvon elektromagnetischen Wellen
lasst sich mit Maxwell-Gleichungen beschrieben [2]:

aD

1. rotH = J +— (2.1)
ot
2. rote =28 (2.2)
ot
3. divB =0 (2.3)
4. divD = p (2.4)

2.3 Elektromagnetische Felder

Der Begriff ‘elektromagnetische Felder' bezeicteiee bestimmte Art bzw. Kombination von

(hochfrequenten) Feldern, welche sich aus elekieisc und magnetischen Feldern
zusammensetzen. Sie entstehen, wenn sich eleldrStiime und Spannungen verandern.
Daraus bildet sich eine elektromagnetische Wellke,stth raumlich ausbreitet und Energie
transportiert [2].

2.3.1 Nahfeld / Fernfeld Theorie

Bei der Abstrahlung eines Dipols unterscheidet maischen dem Nahfeld und dem Fernfeld
[1][3][4]. Sie beschreiben die elektrischen und magnetischeideF und deren
Wechselwirkungen in unterschiedlichen Entfernungam einer Sendeantenne.

Die Region rund um die Antenne bei welcher keindl&ausbreitung auftritt, nennt man das
Antennen Nahfeld. Das Nahfeld wird durch die Lademgind Strome mitbestimmt. Dieser
Beitrag zu den Feldstarken von E und B klingt niit hzw. 1/r3 ab.

Abb. 2.1: Vektorprodukt im Nahfeld

Institut fiir Hochfrequenztechnik 14
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Die Region von jenem Punkt, andem sich die Wetth son der Antenne 16st, wird Fernfeld
genannt. Im Fernfeld spielen Ladungen und StromeekBolle mehr. Die Felder erzeugen
sich durch ihre zeitliche Anderung gegenseitig

Abb. 2.2: Vektorprodukt im Fernfeld

Nahfeld Fernfeld
Grenze Feldbereich i > 3[ Distanz i < 03L[Distanz
21T 21T
Antennendurchmesseb, D.? D.?
Distanz > 270 Distanz< 270
Zeitliche O(E(), H () # 0’ O(E(t),H (1)) =0
Phasenverschiebung
R&umliche Feldvektoren E H
Poynting Vektor S=ExH 3= 1 ExH
2

Tabelle 2.2:Nahfeld / Fernfeld Verhaltnisse [3]

Der in Tabelle 2.2 angegebene Parameter DistaneHhiezich auf den Abstand zwischen
Reader und Transponder und beeinflusst die GrerzeFeldbereichs zur Unterscheidung
zwischen Nahfeld und Fernfeld. Neben der zeitlicRérasenverschiebung die im Fernfeld
null Grad betragt und im Nahfeld ungleich null semuss, gilt als weiteres
Unterscheidungskriterium der raumliche FeldvekiRie Leitungsdichte ergibt sich Uber den
Poynting-Vektor aus dem E-Feld und H-Feld.

2.3.2 Das magnetische Feld

Die Maxwell-Gleichungen des magnetischen Feldes [@h

—

ot = -8 (2.5)
ot
rotH = J (2.6)

Institut fiir Hochfrequenztechnik 15
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divB =0 (2.7)

B=H mit g=pu, (2.8)
Ist u konstant ist, folgt daraus mit (2.6) und J2.8
rotB = 1dJ (2.9)

Mittels divB =0, kann manB durch Einfilhrung des magnetischen Vektorpoterstiae
bestimmen.

B = rotA (2.10)

Die Gleichungen (2.9) und (2.10) fihren zu:

rotrotA = 1J (2.11)
Aus rotrotA = graddivA— AA und der AnnahmelivA = 0 ergibt sich:

graddivA - AA = 1

-NA=1d
AA= -1 (2.12)
Lésungen findet man in der Referenz [2].

Das Biot-Savart-Gesetz (2.13) stellt einen Zusaniraeg zwischen der magnetischen
FeldstarkeH und der Stromdichtd her und erlaubt die raumliche Berechnung magredisc
Feldstarkenverteilungen anhand der Kenntnis denliében Stromverteilungen.
_ di
rotA=—¢  rot— 2.13
4ﬂ§ S (13)

i =

= | o
NI

2.3.3 Magnetische Kopplung fur HF RFID Systeme

HF RFID Systeme arbeiten bei einer Frequenz voB6lBIHz und nutzen das Magnetfeld in
der Antenne im Nahfeld. Alle diese HF RFID Systeweewvenden eine induktive Kopplung.
Aus diesem Grund sind Reader und Tag Antennen iRHDB, Loop Antennen[1] und [4] .

Die Induktivitat ergibt sich aus dem magnetischikrs$durch die Leiterschleife (Loop):

Institut fiir Hochfrequenztechnik 16



Diplomarbeit Gresa&

L =|£ (2.14)

Magnetische Kopplung wird verwendet um Energie ezhes zwei Spulen zu Ubertragen.
Eine ist die Spule des Readers und die andere ele Tdansponders, dargestellt in der
Abbildung 2.3 [6][7].

Fur eine Mehrzahl von Windungen ergibt sich furleeemel aus 2.14:

L :¥ (2.15)

Daraus ergibt sich fur ringférmige Loops mit gegiebr Geometrie [16]:

L= Nz,uoRIn(z—;j (2.16)

wobei N die Anzahl der Spule, R der Radius der @fshund D der Durchmesser des Leiters
sind.

Bei der Kopplung von Spulen spielt der Koppelfalgore wichtige Rolle [1].

k = (2.17)

Wobei die Gegeninduktion M, oder auch induktive Klomg genannt, die gegenseitige
magnetische Beeinflussung zweier oder mehrerer Iréumbenachbarter elektrischer
Stromkreise durch den magnetischen Fldsglarstellt und sich aus der Induktivitat der
Primarspule und der Induktivitat der Sekundarspuodgot [8].

Abb. 2.3: Prinzip der Kopplung zwischen Reader und Tag bé&8d 81Hz [8]

Im Nahfeld nimmt die magnetische Feldstarke H ﬂlgitab [6][71[8]:
r
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1
|H|=r—3 (2.18)

Der Leistungsibertragungsverlust zwischen dem Re&gdeneingang und dem Transponder
Spulenausgang bezieht sich auf die beidseitigekindtét [9][10][11] und die Verringerung

der Ubertragungsdistanz, um den sechsfachen FeRigr= 1/r°).
Als typisches Beispiel der Leistungsubertragungsfak

2
|hHF| = Pax rag ! Prx Reader (2.19)

Zwischen zwei kreisformigen Windungen, die koaxial freien Raum ausgerichtet sind,
ergibt sich [12]:

2 1 (,uoa)anNzazbz)2

h = 2.20
| HF| 4R1R2 (r2 +a2)3 ( )
Symbol Beschreibung
e | Betrag des Leistungsubertragungsfaktors
R Verlustwiderstand der Reader-Antenne
R Eingangswiderstand des Tag-Chips
Ho Dielektrizitatskonstante
@ Kreisfrequenz
N, Anzahl von Windungen auf der
Reader-Antenne
N, Anzahl von Windungen auf der Tag-
Antenne

a Radius der Reader-Antenne
b Radius der Tag-Antenne
r Ubertragungsreichweite

Tabelle 2.3:Liste der Symbole fiir die Gleichung 3.19

2.3.4 FunklUbertragung im UHF RFID System

Anders als bei 13,56 MHz, wo Tag-Antennen im Veagylezu der Wellenlange im freien
Raum (A ;cquy, = 22.1m) viel kleiner sind, ist im UHF Bereich die Antemt@&ge mit der

Wellenlange im freier Raum bei 866MHA,,,, = 346mm )vergleichbar.

Hertz verwendete Maxwell Gleichungen, um das Re&lches von einem idealen Dipol, auch
Hertz Dipol im freien Raum genannt, produziert wizd berechnen. Er stellte fest, dass eine
elektrische und eine magnetische Feldkomponenteingiers proportional mit dem Abstand
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zur Antenne abnehmen, existieren [13][14]. Diesklkgmponenten sind bereits im Fernfeld
der Antenne genannt und kénnen grol3e Distanzembfiloden.

Der Antennengewinn ist eine Mal3grol3e fur die Riatkiwig und den Wirkungsgrad einer
Antenne. Der Gewinn bei 0dBi (dezibel isotropiki) tigpisch fur eine Tag-Antenne. RFID-
Tags sind oft in dem Ubergangsbereich zwischen fétlder Reader-Antenne positioniert,
derartige Modelle sind adaquater.

Abbildung 2.4 stellt eine Funkibertragung zwisclemem Reader und einer Tag-Antenne
dar. Die Transponder Antenne nimmt eine Leistung aud, direkt aus der Rader-Antenne
Ubertragen wird [8].

FiUr den Leistungsubertragungsfaktor gilt:

\h

I’ (2.21)

= PRX,Tag / I:)TX Reader

snent
1t yath COTL\P.{}E"'"
npals . e
11111"_ PP

Ql‘eﬂ ecting object

Jfllt—_'-uf_

sight com Donent

&l
‘e, C C‘i"[‘ag
g TReader

Rl nlup ath componen! 6 i
mudt
reflecting object Q
Abb. 2.4: Darstellung einer Funkiibertragung zwischen ReaderTag-Antenne [8]

Die Leistung, die in das Lesegerat des Antenneneigg PTX Reader eingespeist wird, wird
gemal der Richtcharakteristik der LeseantennennR#aim abgestrahlt. Die Verstarkung der
handelsiblichen Leseantennen liegt typischerweise ungefahr 5 bis 12 dBi. Die
Transponder Antenne nimmt einen geringen Anteil ldgstung direkt aus der Leseantenne
(Ublicherweise als Line-of-sight Komponente bezeeth auf, sowie Signale welche von
Objekten  (Mehrpfadkomponenten) reflektiert ~wordeninds Gewichtet nach
demVerstarkungsmuster der Transponderantenne, nstdiese Komponenten dann am
Transponderantennen-Anschluss zur Verfugung.

Da Low-Cost-RFID-Tags sind im Vergleich zur Well@ngle im freien Raum klein sind,

besitzen sie eine geringe Verstarkung und Effizidsz.
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3 Transponder Antenne (Tag)

Das folgende Kapitel befasst sich mit den Grundiader passiven Transponder Antennen
und deren charakteristischen Eigenschaften futterund UHF-Bereich.

3.1 Passive Transponder, Lesereichweite

Ein Transponder ist ein Funk-Kommunikationsgeraraaisammengefasst:
Transponder=Transmitter+Responder

Passive RFID Transponder besteht aus einer Antandeeinem RFID Chip, welcher zur
Antenne angepasst wird. Sie bendtigt keine eigérmeryersorgung.

Das Wichtigste an einer Tag-Antenne ist die Anpagsuit dem Chip. Diese wird durch die
Relation (3.2) gegeben [20]:

4R.R,

T:|Z Z|2 mit 0<sr<1 (3.1
+

Der Transmissionsgrati wird durch die Chipimpedanz und die Antennenimpedals auch
durch deren ohmschen resistiven Anteil bestimmt.

* ChipimpedanzZ, = R, + jX, (3.2)

* AntennenimpedanzZ, =R, + jX, 3B.

Institut fiir Hochfrequenztechnik 20



Diplomarbeit Gresa&

é R_Antenna
§ R_Chp g R_loss
Q Q % L_fnenna

— c.chp T G loss

b

':' i \_J | _Antenna

Abb. 3.1: Ersatzschaltbild eines Tags [23]

Abbildung 3.1 zeigt das Ersatzschaltbild eines T&ygs, ist hier der Verlustwiderstand und
C, s die Verlustkapazitat.

3.2 HF RFID Tag Antenne

HF-Tag Antennen arbeiten im Kurzwellenbereich be3,56 MHz und verwenden
Lastmodulation. Dies bedeutet dass sie durch Kulieffen einen Teil der Energie des
magnetischen Wechselfeldes reflektieren. Daduratdl was Lesegerat (Reader) erkennbar.
Die Antennen bilden eine Induktionsspule mit medneéindungen.

Die typische maximale Reichweite fur Tags liegt &b m (passiv) und wird bei
Zugangskontrollen angewendet. HF-Tags bieten hoH&ieherheit und eine grol3ere
Informationsspeicherkapazitat, dank ihres NahfBlelriebs [1][24].

Courtesy of Texas Instruments

Abb. 3.2: HF Tag Antenne [19]
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HF-RFID Systeme arbeiten bei einer Frequenz voB6LBJHz und nutzen das Magnetfeld
des Nahfeldes der Antenne, da alle diese Systewhgktive Kopplung verwenden. Aus
diesem Grund sind das Lesegerat (Reader) und demsponder der Antenne
Schleifenantennen. HF Transponder-Antennen fiur R&yBteme bei 13,56 MHz sind
spiralférmige oder rechteckige Antennen.

Es ist wichtig die Eingangskapazitdt des Chips wieeinem reinen UHF Design zu
minimieren, damit das HF-Design auf die Eigenfrequabgestimmt werden kann. Daher
kann die HF Antenne nicht durch die Chipkapazitigestimmt werden, sondern ist auf die
Eigenfrequenz abgestimmt. Das Optimierungskriteriindie Antenne im HF-Bereich ist die
maximale Spannung am Tag-Chipeingang. Dies beddatst weiterhin die Ubertragung der
maximalen Leistung bei beiden Frequenzen erfolgt.

Bei HF-Frequenz Anwendungen wird die magnetischpiing eingesetzt. Die Berechnung
der Kopplung kann Uber der Gegeninduktivitdt M teght umgesetzt werden. Eine exakte
Berechnung der Gegeninduktivitat zweier kreisrundsterschleifen ist mit der Formel 3.4
maoglich[1][3].

(B.4

Die Entstehung der Gegeninduktivitdt durch die Réeplung zweier Spulen Uber das
Magnetfeld wird in Abbildung 3.3 dargestellt. Diis$ die physikalische Grundlage induktiv
gekoppelter RFID- Systemgy, steht fur die Permeabilta,, und R, stehen fir die Anzahl
der Wicklungen und den Radius der beiden Spulgibtxden Abstand der Spulen zueinander
an. Aus der Gegeninduktivitat M kann der Koppluagghr k bestimmt werden[1]:

k=M (3.5)

V L1L2
Der Kopplungsfaktork gibt das Verhdltnis der eingekoppelten Spannunglen zweiten

Spule, zur angelegten Spannung an der ersten Spule, steht fur die Induktivitat der
beiden Spulen [1].

®(1), ¥(i1)

™ Gesamtfluss ¥2(H)

Abb. 3.3: Kopplung zwischen zwei Loops [1]
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Fur batterielose 13,56 MHz Transponder verwendet ntamalerweise ein Resonanzsystem,
um von der Uberh6hung der Antennenspannung pnafitieu kénnen. Der Chip wird aus
dem H-Wechselfeld mit Leistung versorgt und beriédige Minimalspannung zum Betrieb
des Digitalteils.

Daher ist am Antennenanschluss des HF-Transporige(Emoximity oder Vicinity) ein
Plattenkondensator integriert, der zusammen mitiruktivitat der Schleifenantenne einen
Resonanzkreis bildet. Danach folgen ein Gleichechind ein Konstantspannungsregler
(paralleler, gesteuerter Shuntwiderstand), um dian8ung fir den Digitalteil konstant zu
halten. Bei Vicinity-Systemen (Labels fiur Logistilsie EPC (European Product Code))
trimmt man die Resonanz nahe an die Tragerfreq856 MHz [17]. Der Strombedarf des
Chips erscheint im Ersatzschaltbild als ParalletkWiderstand und limitiert die Gite des
Antennen-Resonanzkreises. Nur fir spezielle Anwegdn, wenn z.B. sehr viele Labels
(Transponder) in der Anwendung gestapelt werdensziclget man auf diese
Resonanziberhéhung und bildet eine Eigenreson@hzan. 40-50 MHz ab, da sich viele
Labels durch Kopplung in der Anwendung ohnehin tu@rsen. Bei normalen Transpondern
verwendet man aber diese Spannungsuberhéhung @(nglsereise ist die Uberhdhte
Spannung gleich der induzierten Leerlaufspannuny dea Gite) und erreicht damit bei
einem genidgend starkem H-Feld des Readers und icesrder Antennengrof3e des
Transponders eine gro3ere Distanz, bei der dietigge@Gpannung fir den Chip induziert
wird.

3.3 UHF RFID Tag Antenne

UHF-Tag Antennen besitzen meistens lineare getaltader spiralférmige Dipole, wobei in
der Mitte, der Chip positioniert wird. Tag-Antennemelche meistens ihre Anwendung in
UHF-RFID-Systemen finden, bestehen aus einer dumnenflexiblen Folie aus Kunststoff
oder Papier mit einer gedruckten oder geatzten IN&taung. UHF-Tags uUbermitteln im

Gegensatz zu HF-Tags im elektromagnetischen Fdrdiel Antwort. Diesen Vorgang nennt
man Rickstreuung, wobei die elektromagnetischeé\dbkorbiert wird [2][25].

In der Praxis hat sich fir UHF Antennen ein Rehiein ca 20 Ohm etabliert. Grol3e
Antennenhersteller verwenden Ublicherweise diesent Wir ihre Designs und kénnen Chips
mehrerer Hersteller darauf aufbauen. RFID-Lésungerden im UHF-Bereich deshalb gerne
verwendet, da sie schnelle Schreib- und Lesevom@&nmoglichen. So kdnnen die RFID-
Transponder bis zu einer Entfernung von 4,6 Mebaneiner maximalen Geschwindigkeit
des Tags von 30 km/h ausgelesen werden.

Abb. 3.4: NXP UHF Tag Antenne [19]
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Typisch fur UHF Antennen sind Dipol Antennen, digrah einen Schwingkreis entstehen,
siehe Abbildung 3.4 [19].

ﬁ- .
J —I
kleine Frequenz » grofe Frequenz Dipol

Abb. 3.5:Vom Schwingkreis zum DipdlL4]

Eine der wichtigstes UHF-Tag Kenngrof3en, ist diesdreichweite. Sie ist der maximale
Abstand, bei dem ein RFID Lesegerat das ruckgesti®ignal vom Tag erkennen kann.
Die Lesereichweite wird durch die UHF- Tag-Antwalen Grenzwert, definiert und ist auch
empfindlich auf die UHF-Tag-Orientierung [16].

Die wichtigste Tag-Leistungs Eigenschatft ist diesdreichweite - die maximale Distanz bei
welcher ein RFID Reader die Ruckstreuung eines digules Tags detektieren kann.
Nachdem die Reader Empfindlichkeit typischerweisédn ist als jene des Tags, wird die
Lesereichweite durch den Tag-Antwort Grenzwertrdeft. Die Lesereichweite ist ebenfalls
empfindlich gegenuber der Tag Orientierung, deselMiats auf dem das Tag aufgebracht wird
und den Umgebungsbedingungen. [5]

Die Lesereichweite r kann anhand der Friis-Forraglr] 3.6 beschrieben werden:

(= A |[RGG T (3.6)
4T P

Symbol Beschreibung
A Wellenlange
P Leistung des Senders
G, Antennengewinn des Senders
G, Antennengewinn des Transponders
P, gelieferte Leistung

T Transmissionsgrad ( ca 0.9)
Tabelle 3.1:Liste der Symbole fir die Gleichung 4.6

Das qualitative Verhalten der Antennenimpedanzpi@itpedanz und der Lesereichweite als
Funktion der Frequenz, wird fur typische RFID Tagébbildung 3.6 dargestellt. [5]
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4 Kombinierte HF / UHF Antenne flr
RFID Tags

In diesem Kapitel wird das Design der kombinietdfilUHF Antenne beschrieben. Abschnitt
4.1 gibt einen Uberblick tber die Anforderungendais Antennendesign. Im Abschnitt 4.3.2
und 4.3.3 werden die Antennenstrukturen fir den BéFeich und den UHF-Bereich
vorgestellt. In 4.4 und 4.5 wird die kombinierte t&nne, sowie die Antennengréf3e
beschrieben. Abschnitt 4.6 beschreibt die AnpassiamgAntenne an die Chip Impedanz. In
4.7 werden die Verlaufe der Eingangsimpedanz gezedge durch Simulation von
verschiedenen Antennengrof3en ermittelt wurden.aBueres Modell fir den UHF Bereich
wird in 4.3.4 vorgestellt und in 4.7 diskutiert.

4.1 Randbedingungen und Spezifikationen der HF / UHF
Antenne

Ziel ist das Design, die Simulation und die Hetsted einer kombinierte HF/UHF Antenne
fur RFID Tags, die folgende Merkmale nachweisenngini20][21]:

* Die Antennenimpedanz soll konjugiert komplex zundangsimpedanz des RFID-
Chips im UHF Betrieb sein. Ausgehend von diesem asspngspunkt soll eine
maximale Leistungsibertragung von der Antenne auf BFID-Chip gewahrleistet
werden. Der RFID-Chip hat eine EingangsimpedanzZ/en20 ... 100 — 0 ... 300
im RFID UHF Band. Daher muss das endgiltige AntarDesign eine
Eingangsimpedanz von ca. Z = 20 ... 100 + O ... Q0B diesem Frequenzbereich
erreichen.

 Es wird erwartet, dass eine kombinierte Antennéh Sim HF-Bereich wie ein
Parallelschwingkreis verhalt. Um eine maximale teigsibertragung zu
gewabhrleisten, sollte die Antenne mit der Chip-Erggampedanz eine Resonanzstelle
bei 13,56 MHz und eine Gute von 40 besitzen.

* Das endgultige Design der Antenne ist so ausgetEgs sie an einen UHF- RFID-
Chip angeschlossen werden kann.
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» Die Vorgangsweise beim Design einer kombinierteeine, ist zuerst eine HF- und
danach eine UHF-Antenne zu entwerfen und dieseehefhtennen schlief3lich mit
einer einzigen Anspeisung zu versehen. Da jedoesedieiden Antennen zusammen
parallel angeschlossen sind, wird die UHF-Antenee HF-Bereich der HF-Antenne
beeinflussen und umgekehrt.

Bedingt durch die international unterschiedlichederenzregulierung im ISM-Band, erstreckt
sich der UHF-Bereich Uber ein sehr weites Frequamdlyon etwa 840 — 960 MHz.

4.2 Verwendete Software zum Design der Antenne

Die AWR ® Design Environment (AWRDE) Suite bestedfus drei Komponenten, die
zusammen verwendet werden, um ein integriertese®ysind HF-oder Analog-Design-
Umgebung erstellen zu konnen: Visual System Simdldd (VSS), Microwave Office ®
(MWO) und Analog-Office ® (AO)-Software. Diese Kompenten sind vollstandig in der
AWR Design Environment Suite integriert und ermégén es Schaltungsdesigns in
Systemdesigns zu integrieren. Der grundsatzlichéwiEklungs-Ablauf in der AWR
Designumgebung ist durch ein Flussdiagramm in ddgildung 4.1 dargestellt [26].

Create Project
File > New Project or File > New with Library

Set Units, Environment Oplions
Options > Project Options

Create Schematics/Diagrams (MWO/AQ) Create Layout
Project > Add Schem./Sys. Diagram)| View > View Layout
View > View Schematic

Set Frequency, Simulation Options
(MWO/AD) Options > Def. Circuit Options
(VSS) Options > Def. System Options

Create Graphs/Measurements
Project > Add Graph
Project > Add Measurement

Simulate Circuit
et (MWOUADH) Simulate > Analyze ——

(¥33) Simulate > Run Sys. Sim. -
(MWOIAD) Oplimizing Tuning
Simulate > Optimize Simulate > Tune
Set Optimization Goals Manually Vary Parameters
Project > Add Opt Goal Simulate > Tune Tool
Automatically: Automatically:
*Updates Schem./Sys. Diagrams *Updates Schem.Sys. Diagrams

*MWOC/AQ) Updates Layout
*Simulates
*Updates Resulis/Graphs

H(MWCOYAQ) Updates Layout
*Simulates
*Updates Results/iGraphs

Abb. 4.1: Entwicklung-Ablauf (Design Flow)
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e CST Studio Suite:
Im Rahmen der Arbeit wurde die Finite Element Meian¢FEM) Software zur Verifizierung

der ersten Ergebnisse verwendet.

Das Programm ist speziell auf eine schnelle unitieffte Analyse und Design von EM-
Komponenten, wie Antennen geeignet. Wie bei AWR rkadie Impedanz, der
Reflexionsfaktor , der Gewinn usw. graphisch daeji#swerdem. Hier wurde ein RFID
Simulator verwendet [27].

« Eagle:
Diese Software ist der vorletzte Schritt um ein dutyzu erstellen, bevor Prototypen der
Antenne hergestellt werden kénnen. Von den mogticbptionen wurde hier nur die Layout-
Option genutzt, um ein gefrastes Board als Prothiyphabormessungen erstellen zu kénnen
[28].

4.3 Design der Tag Antenne
Eine Tag-Antennen Konstruktion besteht grundsdizigs :

* Einer einzelnen Metallschicht fur den Leiter (keMassenflache)
* Einem sehr diinnen oder im Idealfall flexiblem Stdust

« Die Herstellung des Antennenleiters ist durch Fragézen und auch durch
Druck mdglich

Fur das Design einer effizienten Antenne ist esvantig, den Realteil und den Imaginarteil
der konjugiert komplexen Quellimpedanz zu erreichdie in den meisten Fallen der
Transponderchip ist. Die Herausforderung des Argefidesigns ist die Sicherstellung dass
die UHF- Antenne:

* eine minimale Wechselwirkung mit der HF- Spule Amte besitzt
* mit der HF- Spulen- Antenne kombiniert werden kand dass
* sie so wenig zuséatzlichen Platz als mdglich behétig

Die RFID-Antenne soll bei 13,56 MHz (HF) und 8@&B0 MHz (im UHF-Band fur RFID-
Betrieb) betrieben werden kdnnen. Breitbandige Améadesigns kdnnen fir Impedanzen mit
relativ hohem Real- und mdglichst niedrigem Imageié am Besten designed werden.
Allerdings beeinflusst die geringe Grole der Antenviele Faktoren, wie z.B. die
Verstarkung, die Impedanzanpassung und die Baridja4].
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4.3.1 Definition

Das kombinierte RFID-System wird gemaR ISO/IEC H&%andard [17] im HF-Band und
gemald ISO/IEC 18000-6-AMD1 Standard [18] auf dem RB&nd realisiert. Die
Funktionalitat bei beiden Frequenzen mit einem Tagp,der nur einen einzigen Port zur
Verfugung hat, soll sichergestellt sein. Die Antenrnwird auf die maximale
Leistungubertragung bei beiden Frequenzen optimiert

4.3.2 HF Design

Fir den HF Bereich wurde eine planare Schleifemar@emit mehreren Windungen
entwickelt. Die Berechnung der Induktivitat eindreaen Mehrwindungs- Schleifenantenne
erfolgt durch [5][8] [20]:

1

2\ LC

Mit der bendtigten Resonanzfrequenz bei 13,56 Mékst sich die erforderliche Induktivitat
berechnen.

Unter Verwendung eines Coilcalculator, einem Progmazur Berechnung der einzelenen
Komponenten der Antenne, ergeben sich fur méine (5 Windungen) HF-Loop-Antenne

mit einer Grol3e von 30.2x20.2 fur die Induktivilas uH, die Kapazitat 1.53 pF und fir den
Widerstand 3.29.

fo = (4.1)

Die folgende Abbildung 4.2 zeigt das Design der Atffenne, mit einem Abstand von
w = 0.2mm zwischen zwei Windungen und einer Breite der lggtuond = 0.2mm.

Abb. 4.2: HF-Antennendesign
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4.3.3 UHF Design

Wichtige Faktoren fiur die Dimensionierung der Amtensind neben den Einflissen der
Materialien, die maximal zuldssige geometrische 38roder Antenne, sowie die
frequenzabhangigen Eigenschaften der ChipimpedBr@nsponder im Smart Card Format,
die fur einen Betrieb im UHF-Bereich ausgelegt sinérfligen tber elektrisch kleine
Antennen. Eine wesentliche Eigenschaft dieser Argrenist der Ublicherweise niedrige
Realteil der Impedanz im Bereich der 1. Serienrasan Damit verbunden sind eine hohe
Gute und eine geringe Bandbreite. Durch Beeinflngsder Antennengeometrie fur eine
optimale Nutzung der Flachen ist es mdglich, dipddanzeigenschaften so zu veréndern,
dass sich die Bandbreite der Antenne vergroRermitS@mpfangt die Antenne die
elektromagnetische Energie der Freiraumwelle undrgtsogleichzeitig fur die
Impedanzanpassung. Die Geometrie der Antenne elchb@ine gute Anpassungen uber
einen weiten Bereich der Chipimpedanzen vorzunehm@lterdings beeinflusst die
Chipimpedanz wiederum die Bandbreite der AntenB{i8].

Konfiguration Single ended Differential

Linearisiertes Modell des Tags und der 530 Q || 980 fF 1050 Q || 680 fF
Mounting-Kapazitat

Empfohlene Antennen- 868 MHz (53+j166) Q (66+j254) Q
impedanz bei geringster

Empfindlichkeit
956 MHz (48+j153) Q (55+j233) Q

Tabelle 4.1:Schaltungsvariablen und Impedanzen

Die Antennen werden oberhalb ihrer 1. Serienresometrieben, um den kapazitiven Anteil

der Chipimpedanz zu kompensieren. EntscheidendiéiBandbreite ist nun die Anderung

Uber den Frequenzen von Real- und Imaginarteil ereiBh des Arbeitspunktes oberhalb der
1. Serienresonanz der Antenne. Je hdher der kaygaZinhteil der Chipimpedanz ist, desto

schmalbandiger wird die Antenne.

Im UHF Bereich wurde ein Halbewellen-Dip@y2 (fir 960 MHz) mit 2 Resonatoren
verwendet, um die Antenne im Resonanzbereich stbarelig als mdglich zu machen. Ein
Anpassungspunkt ist erforderlich, um die Eingangsdanz der Antenne auf
Z,r =21+120jQ zu transformieren.

Die UHF-Antenne besitzt eine GréRe v@@.8mmL 28mm. Fir grof3e Entfernungen ist der
Dipol im Vergleich zu einer Schleife die besserelW&olgende Abbildung (4.3) zeigt das
Design der UHF- Antenne:
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| 50|

\

\ Schwingt bei 926H¢ /

Schwingt bei 866 MHz

Abb. 4.3: UHF Antennendesign

Es werden zwei Dipole verwendet, da es zwei Restirequenzen, 866 MHz und 926MHz
gibt.

4.3.4 UHF Dog Bone Design

Es wurde noch eine alternative Version der Antefimeden UHF Bereich entworfen und
entsprechende Simulationen und Messungen durchgefie Simulation hat gezeigt, dass
dies eine optimale Antenne im UHF Band sein konjeoch die Kombination mit der HF
Antenne schwer realisierbar ist. Fir die Paralf@#tang der UHF und HF Antenne wéren
zusatzliche Elementen, wie zum Beispiel Plattenkosdtoren, notwendig. Wegen des
grof3en Zeitaufwandes wurde entschieden das Dog-Besmgn nicht weiter zu verfolgen.

Abbildung (4.4) zeigt das Dog Bone- Design.

=i

Abb. 4.4: Dog Bone UHF Design
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4.4 Design Anforderungen an kombinierte Antennen

Mehrere allgemeine RFID-Tag Anforderungen, derelativ® Bedeutung von der Tag
Anwendung abhangen, werden in diesem Kapitel bedtanDiese Anforderungen bestimmen
weitgehend die Auswahlkriterien einer RFID-Tag-Amte.

Das gewitinschte Frequenzband fir den Betrieb hamgten Bestimmungen des Landes, in
dem das Tag verwendet wird, ab.

Die Form und Gréf3e des Tags muss so beschaffendasa sie in das gewiinschte Objekt
(Kartons, Fluggepack Streifen, Ausweise, etc.) eegtet oder angebracht werden kann.

Die minimal erforderliche Lesereichweite ist in dRggel angegeben fir:

* Objekte: Die Tag-Leistung verandert sich, wenn esverschiedenen Objekten (zB
Kartons mit verschiedenen Inhalten) platziertasier wenn andere Gegenstande in der
Néhe des Objekts markiert sind. Tag-Antennen kormeroptimalen Leistung auf ein
bestimmtes Objekt abgestimmt oder entwickelt werd@der sie kdénnen so
konstruiert werden, dass sie weniger empfindlichdan Stoff auf dem das Etikett
angebracht ist, reagieren.

* Orientierung: Die Lesereichweite hangt von der Audung der Antenne ab. Einige
Anwendungen erfordern ein Tag, um eine bestimméhtlngscharakteristik wie eine
radiale oder hemisphérische Abdeckung zu erhalten.

Ein RFID-Tag muss ein kostengunstiges Gerat seies Blihrt zu Einschrankungen der
Antennenstruktur, als auch der Materialauswahtférkonstruktion einschlief3lich der ASIC.
Typische Leiter welche in Tags verwendet werded iapfer, Aluminium und Silber.

Des Weiteren muss ein RFID-Tag eine hohe Zuveglsgi besitzen, welches Variationen
von Temperaturen, Feuchte, Druck, Labelzufihrunmgcken und Laminieren aushalten kann.

Eine UHF-Antenne ist eine Breitbandantenne (ca.Hz Bereich). Ziel ist die Beibehaltung
dieser Bandbreite auch bei der Kombination mit dér Spule. Die HF Struktur wird die
UHF-Antenne beeintrachtigen, was leider nicht zamaiden ist. Dennoch teilen sich die
beiden Frequenzbereiche auf. Die HF Antenne sotieke Kurzschluss der UHF Antenne
hervorrufen und umgekehrt. Jedoch beeinflusst di#4ntenne die HF-Antenne kaum, da
sie sich als eine geringe parasitare KapazitatdiarUHF-Antenne auswirkt. Idealerweise
stellt die Kapazitat einen Kurzschluss fur UHF-Amte dar, da sie fur hohere Frequenzen
besser leitend wird.

Ein Problem der direkten Kopplung von HF und UHFeiner einzelnen Antenne, ist die
Aufteilung der Empfangsleistung. Der jeweils and&mquenzbereich wird demzufolge
immer etwas Verluste, gegentuber einer fir einereiBleroptimierten Antenne machen. Die
Antenne soll in Anpassung die konjugiert komplemgédanz zum Chip bekommen. Meist
soll die Antenne breitbandig realisiert werden, demn Frequenzbereich von 860-960 MHz
abzudecken. Das einfachste Konzept um dies zucbkem] ist der Einsatz der zwei
Resonanzfrequenzen im Design.
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4.5 Wabhl einer sinnvollen Antennengrél3e

Die verwendeten Materialien fur die Herstellung:
Substrat FR4 . . . . mit Dielektrizitatkonstantend Starke von 0.8 mm

Kupfer......... mit eine Dicke von 0.2 mm

RFID Chip LIHF Artenne

X
HF Antenne ngspunkt HEUHF

Abb. 4.5: HF / UHF Antennendesign mit AWR

Abb. 4.6: HF / UHF Antennendesign mit CST
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4.6 Anpassung der Antenne an die Chip Impedanz

Um die groRtmdgliche Leistung aus dem elektromaggcietn Feld in den Chip zu bringen,
missen die Antenne und der Chip angepasst werddnldéing 4.7 zeigt die Ersatzschaltbild
der Tag-Antenne und der Tag-Chip Impedanz [8].

|

] |
| |
I |
| |
1 |
| |
| |
1 |
1 |
: | |Zeu |
1 |
| |
| |
] |
| |
| |
1 |
1 |

Abb. 4.7: Ersatzschaltbild Tag-Antenne und Chip

Der HF/UHF Chip hat keinen integrierten Kondensatiar er das UHF-Frequenzband viel zu
stark dampfen wirde.

Da aufgrund technologischer Grenzen die Eingangsitapz des Chips nicht beliebig gewahlt
werden kann, muss die Antenne so entworfen wenthess die Chip Impedanz bestmaéglich an
die Antenne angepasst werden kann. Fir die Leisamgassung gilt die Bedingung:

— >0
Z, =Z chip

Der Chip CTSO, der in meinem Design verwendet wivdtd von Infineon Semiconductor
hergestellt. Abbildungen 4.8 und 4.9 zeigen Chipdgnz und die Chip- Gehéuse.

Abb. 4.8: Chipimpedanz
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Top View
B-poliges plastc Gehluse

Bezeichnung: CTS0

Abb. 4.9: Infenion-Chipgehause

4.7 Simulation der Antenne

Dieser Abschnitt beschaftigt sich mit der Simulatider kombinierten Antenne im UHF
Bereich. Simulationen wurden durchgefiihrt, um diarkdhg von einigen Schlissel-
Parametern zu bestimmen, wie die Eingangsimpeddee, Reflexionsfaktor und das
Abstrahlverhalten der Antenne. FiUr die Simulationger Eingangsimpedanz und des
Reflexionsfaktors wurde die AWR/CST Software unddés Abstrahlungsverhalten die CST
Software verwendet.

Um eine maximale Reichweite bei minimaler Leisturmy erreichen, muf3 die
Antennenimpedanz gemal der Chip Eingangsimpedativnieg werden. Der Chip hat eine
Kapazitat, die dasS, und die Impedanz der Antenne verschieben kanngeRde

Abbildungen zeigen in AWR und in CST die Eingangs&aianz und den Reflexionsfaktor der
Antenne.
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Abb. 4.10: Eingangsimpedanz fir HF / UHF Antenne (AWR)

Zoeo = 20+123)Q und Z,,, =12+182jQ

Die grof3te Schwierigkeit besteht darin, Kopplunfiddé zwischen den beiden Antennen zu
minimieren. Die Kopplung am ReflexionskoeffizierardJHF Antenne sichtbar (Abbildung
4.11). Wenn man unter die HF Antenne eine Masdaflasetzt, so verschwindet die

Resonanzfrequenz zwischen 400-600MHz.

Wenn die Anpassung von Q0abweicht, so wirden der Real- und Imaginéarteilldgredanz
aulBerhalb des UHF Bereichs liegen. BeiQ50iegen diese genau im Bereich des

Reflexionsfaktor (866-960MHz).

In Abbildung 4.11 istS, auf die konjugiert komplexe Portimpedant normiétan erhéalt
somit den Anpasspunkt der Antenne. Die Ports diffdrentiell simuliert worden.

Graph 1 =DB(S(1.1))

10 antenna_matching

| o o — S — S 9396 MH

=
o
-10 &
9801 MHz
-11.42dB

-20
-30

0 400 800 1200

Frequency (MHz)

Abb. 4.11: S, fur HF / UHF Antenne (AWR)
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Die Antenne ist auf 32 normiert und auf die Chip Kapazitat angepasst.

SUBCKT
PORT ID=S1
P=1 NET="EM Structure 1"

Z=50 Ohm

CAP
ID=C2

C=0.3 pF

13,56 T2
r'Jp--“‘I' o
——— T T —

L ] T
30 25 50 75 100 125150 175 200 225 25,

Abb. 4.13: Giite der HF Tag Antenne

Die Gite der HF Tag Antenne ist fast 40 bei 13,38zMDie erforderliche Chipkapazitat fur
eine Resonanz bei dieser Frequenz ist 14pF. Beeditapazitat verschiebt sich die Resonanz
um ca. 80-100 MHz, diese ist die Grenze fir die Koration beider Antennen im HF
Bereich. Zu sehen in der Abbildung 4.10.

Die Geometrie hat einen grofR3en Einflu3 auf die Anemparameter. Wenn man den Abstand
zwischen den Windungen der HF Antenne auf O.lmmmwetert, wirde die
Resonanzfrequenz bei etwa 18 MHz liegen. Da diestdiung von Leitungsabstanden
unmadglich war, wurde bei 0.2 mm gemessen. Wenn dianBreite der UHF Antenne
verandert (Mitte breiter), wirde sich die Impedaozie der Reflexionsfaktor andern. Der
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Real- und Imaginarteil der Impedanz wirde glatted weiter nach rechts verschoben werden
und S, wirde sich verschlechtern. Es wirde auch einigssipren, wenn die HF Antenne

Uber die UHF Antenne eingeschlossen ware. Siehddibity 4.15.

Graph 2

2000

1000

‘ ‘ -1000

-2000

Frequency (MHz)
Abb. 4.14/aAntennendesign Abb. 4.14/b:Impedanz
-+-S(1,1)

Swp Max EM Structure 1

1200MHz
=5(1,1)
antenna_matching

Graph 1

938.6 MHz
34

dB
0 W /
/ /aw
- | o 960.2 MH:
i %" -11.89 dBZ]

900.2 MHz|
-14 27 dB

823.7 MHz
-r23.2698
x-0.631967

i 941.3 MHz
r4.77225
x-0.0214973

968.7 MHz
r1.11451
x-0.0022104

-20

909.8 MHz
\ \ r 1.41396
x 0.00905569

-30 \
0 400 800 1200
Frequency (MHz)

Swp Min
O0MHz

Abb. 4.14/cS Abb. 4.14/d: Smith Diagramm

In der Graphik 1Abb. 4.15/c sieht man deutlich, dass der RefleXakier schmalbandig
wird, im Vergleich zu Abb. 4.11.

Die Ergebnisse wurden mittels CST Software ersteik folgenden Abbildungen stellen die
Eingangsimpedanz, den Reflektionsfaktor und dastrAbkingsverhalten der kombinierten
Antenne von 800MHz bis 1.1GHz dar.
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Abb. 4.15: Realteil der Impedanz der HF / UHF Antenne (CST)
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Abb. 4.16: Imaginérteil der Impedanz der HF / UHF Antenne TES
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Abb. 4.17: S; der HF / UHF Antenne (CST)
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Abb. 4.18: Abstrahlungsverhalten der HF / UHF Antenne (CST)

Im folgenden wurde versucht die Dog Bone Antennied®i HF Antenne zu kombinieren. Die
Simulationsergebnisse fir die Impedanz, den Reftestaktor und das Abstrahlungsverhalten
der Dog Bone Antenne sind in Abbildung 4.19 abgkdtil Die Ergebnisse sind im

Frequenzbereich von 500 MHz - 1.1 GHz dargestellt.

Abb. 4.19: HF / UHF Dog Bone Antennendesign (CST)
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Folgende Abbildung zeigt den Reflexionsfaktor d&¥R Simulation.
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Abb. 4.20: S, der HF / UHF Dog Bone Antenne (AWR)
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Abb. 4.21: Realteil der Impedanz der HF / UHF Dog Bone An&e(DST)
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Abb. 4.22: Imaginarteil der Impedanz der HF / UHF Dog Bonaehme (CST)
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Abb. 4.23: Sll der HF / UHF Dog Bone Antenne (CST)
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Abb. 4.24: Abstrahlungsverhalten der HF / UHF Dog Bone An&e(DST)

Eine weitere Variation der Antenne ist in AbbilduA@5 zu sehen. Eine einfache Malinahme
ist, direkt an den Chip in Richtung der HF Antezn@achst eine (passend grof3e) Induktivitat
anzuschliel3en. Dies kann eine planare Spiraleasrbahn sein. Fur kleine Frequenzen (HF)
soll sie einen geringen Widerstand besitzen, flineh&requenzen (UHF) hingegen einen
hohen Widerstand. Da die Induktivitat die richtigguktur zur Ankopplung der HF Antenne
ist, wurde hier eine Serpentinenstruktur verwend®e Induktivitat hat bei niedrigen
Frequenzen eine kleinere Impedanz.
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Abb. 4.25: HF / UHF Dog Bone Antennedesign Nr.2 (AWR und CST)
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Abb. 4.26: Realteil der Impedanz der HF / UHF Dog Bone AngehNm.2 (CST)
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Abb. 4.27:Imaginarteil der Impedanz der HF / UHF Dog Bondefime Nr.2 (CST)
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Abb. 4.28: S/, der HF / UHF Dog Bone Antenne Nr.2 (CST)
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Abb. 4.29: Abstrahlungsverhalten der HF / UHF Dog Bone Antehim.2 (CST)

Institut fiir Hochfrequenztechnik



Diplomarbeit Gresa&

5 Messungen der Antenne

In diesem Abschnitt wird die kombinierte Antennet dem Stecker vermessen. Fir den
gesamten Messvorgang werden ein Netzwerkanalysatbrein 50 Ohm Kabel verwendet.
Um die Genauigkeit und Vergleichbarkeit der Daten gewahrleisten, muss der
Netzwerkanalysator kalibriert werden. Die Kaliloueg wird im Abbild 4.30 dargestellt.

- ioe ecoe ee . [

1'1 (..:.- (---‘L——b(.. = \ I

Abb. 5.2: Kalibrierstecker (calibration kit), Netzwerkanalysaund 50 Ohm Kabel

Nach der Kalibrierung wird die Antenne, ohne Chifer ein 50 Ohm-Kabel mit dem
Netzwerkanalysator verbunden. Die Messung wurdesijewiir den 450 MHz und fir den
HF- und UHF- Frequenzbereich durchgefuhrt, wobeiRleflexionsfaktor und die Impedanz
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fur beide Bereiche erfasst wurden. In den Graphetert auf Grund parallel laufender
Messungen kleine Abweichungen auf, jedoch wurdem Messergebnisse dadurch nicht
verfalscht.

Abb. 5.3: Antenne mit dem Netzwerkanalysator mittels 50 Ohathéd verbunden

Die folgenden Abbildungen zeigen den Reflexionsiakind die Impedanz fur den HF-
Bereich.

%1 Real 100 ©2/ Ref400 O 1
Z<—S‘I'It
— 800
— 700
— 600
— 500
— 400
— 300
— 200
— 100
F— o
Ch1 Start 5 MHz Pwr -10 dBm Stop 50 MH=z

Datc: 13.APR.2012 1 L2 s

Abb. 5.4: Realteil der Impedanz im HF Bereich der HF / UHRekme

Der Realteil muss hoch ohmig sein.
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Abb. 5.5: Imaginarteil der Impedanz im HF Bereich der HF /R’JRntenne

Im Weitern werden die Ergebnisse im UHF-Bereichydatellt, jeweils die Impedanz und der
Reflexionsfaktor (Smith Diagramm) fir den obereQMIBiz und unteren 866 MHz Bereich.

SR

:I:?c‘l Real 20 Q/ Ref60 O Cal 1
Z<—S1’II

— 140

F— 120

— 100

— 8o

— 60

40 ——

— =20

— o

— -20

Ch1 Center 900 MHz Pwr -10 dBm Span 200 MH=z

Dastbens: 2. 8FR..2012 128G B

Abb. 5.6: Realteil der Impedanz im UHF Bereich (866 — 924a)Y1dHer HF / UHF Antenne
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Abb. 5.7: Imaginarteil der Impedanz im UHF Bereich (866 4 92Hz) der HF / UHF Antenne

Trec dB Mag 5dB/ Ref-15dB Cal 1
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Abb. 5.8: Reflexionsfaktor im UHF Bereich (866 — 924 MHzY ¢~ / UHF Antenne
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Tre1 Smith Ref1U Cal 1
S11

Ch1 Start 800 MHz Pwr -10 dBm Stop 1 GHz

Date: 27.APR.2012 12:34:49

Abb. 5.9: Reflexionsfaktor im UHF Bereich (866 — 924 MHzY ¢~ / UHF Antenne

Im Smith Diagramm ist deutlich zu erkennen, dasskdmbinierte HF/UHF Antenne induktiv
bleibt.

Da bei der Simulationen auch eine Resonanzfreqmeischen 400-500 MHz zur Verfigung
stand, wurden auch in diesem Frequenzbereich Mgesaufiir die kombinierte Antenne
durchgefihrt. Siehe folgende Abbildungen:

:Fi;c‘l Real 50 QQ/ Ref 150 Q2 Cal 1
Z—S1 ’II
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L 50 N
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Date: 13.APR.2012 123 binsld

Abb. 5.10: Realteil der Impedanz im UHF Bereich (450 — 5504 Her HF / UHF Antenne
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Abb. 5.11:Imaginarteil der Impedanz im UHF Bereich (450 0 38Hz) der HF / UHF Antenne

Es wurde nun noch die UHF Dog Bone Antenne gemessdrdie Ergebnisse interpretiert.
Vergleicht man die Ergebnisse mit jenen der Sinmutatso ist daraus ersichtlich dass diese
Antenne suboptimal ist.

T
Trc1 Real 100 QQ/ Ref600 Q Cal 1

T
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- w00—-
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— 400

— 300

— 200

Ch1 Center 900 MHz Pwr -10 dBm Span 200 MHz

Date: 27 .APR.2012 12:43:38

Abb. 5.12: Realteil der Impedanz im UHF Bereich der Dog Bo¢R Antenne
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Abb. 5.13:Imaginarteil der Impedanz im UHF Bereich der DoghnB&HF Antenne
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Abb. 5.14: Refelxionsfaktor im UHF Bereich der Dog Bone UHFtédme
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Abb. 5.15: Refelxionsfaktor mit Smith Diagramm im UHF Bereigér Dog Bone UHF Antenne

5.1 Reader-Tag-Antennen Messung im HF Bereich

Die Messung wird mit Hilfe eines Lesebefehls Uber dSB- Schnittstelle zu einem RFID
HF-Reader (Feig Reader von OBID) initiiert. Der Beaaktiviert daraufhin das HF Feld und
versorgt damit den batterielosen RFID Chip mit greerDie gewtinscht@ntennenLeistung
konnte Uber eine Software im Rechner umgestellderer Wird das Tag aus dem HF-Feld
entfernt, so bekommt der Reader auf seinen Aufmihé& Antwort und es erscheint eine
Fehlermeldung. Der beriihrungsfreie Abfrageabstairdyhvon der Leistung des HF-Readers
und der Antennengrél3e ab und liegt typischerwiaisBereich von 10 — 30 cm.

Kenndaten:

- Ubertragungsfrequenz 13.56 MHz

- Sendeleistung HF-Reader 2-3W

- Lesereichweite typisch 10 cm

- RFID Protokoll ISO-15693

- RFID Chip CTSO

- Abmessung Reader Antenne 200x200mm
- Abmessung Tag Antenne 30.2x20.2mm

Yfur angegebene Sendeleistung und Antennengrof3en
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In der Abbildung 5.16 wird der HF Reader dargestell

Q30 Erler07 27.09.2004
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Abb. 5.16:HF Feig Reader von OBID (Lesegeréat)

Die Leistung wurde mit Hilfe einer Software (OBID ISO Program) geandert und auf den
Reader gesendet. Siehe Abbildung 5.17 fur Detalils.

R |

Abb. 5.17:OBID ID I1SO Start Programm

An der Stelle des Cursor wird die Leistung verahder
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5.2 Reader-Tag-Antennen Messungen im UHF Bereich

Gesteuert wird die Abfrage Uber einen PC, sowienbBieader im HF Bereich. Der hier
eingesetze Reader, ist ebenfalls ein Feig ReadeOBID. Die Messung wird mit Hilfe eines
Lesebefehl Uber die USB-Schnittstelle zu einem REIBF-Reader initiiert. Der Reader
aktiviert daraufhin das UHF Feld und versorgt dadeih batterielosen RFID UHF Chip mit
Energie. Die Daten werden nach dem weltweit vengm|SO-18000-6 (EPC Gen2 Class 1)
Standard Ubermittelt, wenn der Reader den Tag lssge hat (siehe Abbildung 5.18 und
5.19). Dann wurde mit einen Mal3band die Distanz Reader bis zum Tag gemessen.

Kenndaten:

- Ubertragungsfrequenz 868MHz

- Sendeleistung HF-Reader 0-3W

- Lesereichweite typisch 1m

- RFID Protokoll ISO-18000-6 (EPC Gen2 Class 1)
- RFID Chip CTSO

- Abmessung Reader Antenne 200x200mm

- Abmessung Tag Antenne 77.8x28mm

Der beriihrungsfreie Abfrageabstand hangt von destwey des UHF-Readers und der
Antennengroéf3e ab und liegt typischerweise im Barean 0.5 — 3.0m.

Abb. 5.18: UHF Feig Reader von OBID (Lesegerét)
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Abb. 5.19:EPCglobal Programm

Abb. 5.20: Labor Equipment und Messablauf
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Es wurde die Antenne und die Referenz Antenne anf 8essel befastigt und mit dieser hin
und her bewegt, bis der Reader die Antenne erfaaist An der Stelle der Linie wurde

gestoppt und der Abstand gemessen.
Folgende Abbildungen zeigen die Prototypen der Amt@, die in den Messungen verwendet

wurden.

Abb. 5.21: Kombinierte HF / UHF Antenne mit Chip

Abb. 5.22: UHF Dog Bone Antenne mit Chip

Abbildung 5.23 zeigt die ideale Dipol-Antenne die Referenz Antenne verwendet wurde.

Abb. 5.23: Ideale Dipol-Antenne mit Chip

5.2.1 Zusammenfassung der Ergebnisse im UHF Bereich

In der folgenden Tabelle wurden die Ergebnissemusengefasst. Es wurde die kombinierte
Antenne und Dog Bone Antenne gemessen. Nebenbeevauch eine ideale Dipol-Antenne
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und eine NXP UHF Antenne als Referenz Antennen geere um die Ergebnisse vergleichen
zu konnen.

Leistung pHF idealer NXP Referenz Kombinierte UHF Dog Bone
Dipol Antenne Antenne HF/UHF Antenne Antenne
0.3 W 0.54 m 3.50m 0.60 m 0.20 m
0.6 W 1.26 m 3.50m 0.80 m 0.40 m
0.9WwW 1.50 m 3.50m 1.10 m 0.45m
1.2W 1.65m 3.50m 1.40m 0.50 m
15W 2.00 m 3.80m 1.60 m 0.60 m
1.8W 2.00 m 420 m 2.00 m 1.00 m
21W 210 m 4.60 m 2.30m 1.20 m
24 W 2.20m 5.60 m 2.50m 1.50 m
2.1 W 2.30m 6.60 m 2.70m 1.50 m
3.0W 2.50m 7.20m 3.00 m 1.70m

Tabelle 5.1:Uberblich der Messergebnisse
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6 Zusammenfassung und Ausblick

Im Zuge dieser Arbeit wurde ein detailliertes Desfgr ein hohes Frequenzverhéltnis der
kombinierten Antenne prasentiert. Simulierte unchgsesene Ergebnisse wurden angegeben,
um die Funktionalitat im HF- als auch dem UHF-Belnezu bestéatigen. Diese Arbeit hat sich
mit der Optimierung der AntennengrofR3e auseinandetge Tests mit einem RFID-Chip an
der Antenne wurden durchgefiihrt. Die entworfene liioimerte Antenne konnte als RFID-Tag
zu einem gangigen Produkt werden. Somit wird enegtdre Einfiihrung von RFID-Systemen
bestatigt.

HF ist die klassische und sichere Art der Kommutigkain RFID und benétigt daher mehr
Strom, woraus die 10 cm Lesereichweite resultiertGegensatz dazu besitzt UHF eine grol3e
Reichweite von ca. 10m. Diese fihrt zu einer Riatkung, sodass man in relativ kurzer Zeit
viele Tags auslesen kann. Aufgrund der geringestlueg hat man wenig Sicherheit, d.h. im
Wesentlichen handelt es sich nur um eine Serienrannm

Im HF-Bereich existiert in der Anwendung Kryptognag z.B. bei Payment-Anwendungen,
eine RSA-Verschlisselung mit 1200 byte Lange um Slherheit zu gewahrleisten. Die
GroRRenordnung der Leistung liegt im HF-Bereich B@WwW. Im UHF-Bereich liegt diese bei

einer GrolRenordnung von 1-50mW. Im HF-Bereich aebe&iormalerweise ein Prozessorchip
und im UHF-Bereich eine State-Maschine.

6.1 Idee fir die Anwendung

Es stellt sich die Frage: Wo kdnnte die Antenngesetzt werden?

Die entwickelte kombinierte Antenne koénnte zur dheieitigen Zahlungs- und
Zugangskontrolle verwendet werden. Wenn eine Pemgelthe ein Tag mit sich fuhrt, in die
Néhe eines Readers kommt, so konnte diese Pergustriedt werden und deren Daten
ausgelesen werden. Dies kénnte man als Paymentianigalisieren, z.B. als RFID-Uhr oder
-Patch fur einen Freizeitpark (ber welche man allehlungen tatigen kann. Die
Zahlungskontrolle wirde tUber den HF-Bereich erfolgasnd der UHF-Bereich wirde zur
Zugangskontrolle der einzelnen Attraktionen dienen.
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